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1 Overview of Machine Tool Graphic User Interfaces

1.1 Abbreviations Used

In addition to product names and system designations, the abbreviations
listed below are used in this documentation.

Abbreviation Explanation

TM Tool Machine

MTGUI Machine Tool Graphical User Interface

M keys Configurable machine keys

F keys Configurable function keys

Fig. 1-1: Abbreviations used

1.2 General Information About the MTGUI System

Bosch Rexroth MT interfaces (MTGUI = Machine Tool Graphic User
Interface) enable users of machine tools and transfer machines to:

• operate

• configure

• parameterize and to

• program.

Bosch Rexroth Control Systems with MTGUI
Bosch Rexroth control systems, such as

• MTC200

• ISP200

• TRANS200 and

• MTA200

can be uniformly configured and operated to a great extent with the
MTGUI.
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MTGUIAnw_gr.bmp

Fig. 1-2: Bosch Rexroth control systems

Characteristics of the MTGUI System
• Standard user interface, standard configuration tool (look & feel) with

simple and comprehensive keyboard operation

• Use of Windows as the global standard for PC systems

• Configurable interface

• Integration of external components (open interfaces, 3rd party
software)

• Operating system platforms: WinNT, Windows2000, (Win95/Win98)

• Modularization to create project-specific interface versions at
application level

• Standard user interface, even in a heterogeneous production
environment

• Up-to-date Windows concepts for editing and commissioning

• Support of distributed systems (network of PCs)

• Multilingual user text (e.g. program comments)

• Reduced application, service and training costs

Thanks to the standard MT interface, the user can quickly learn how to
operate various Bosch Rexroth controls.

Concept of MT Interfaces
The MTGUI system contains subdomains for the expansion of an MT
interface, which enables the applications for the MTGUI system to run in
various desktops.

The modular character of the application software means that various
control systems can be combined.

At the maximum expansion level of the MTGUI system, applications can
be run with four desktops.

Advantage
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• During runtime, all applications are distributed between 4 desktops

• It is easy to switch between all 4 desktops; they can be active at the
same time

• Each desktop contains a corresponding set for applications, such as
all NC functions

• Distribution to several desktops improves the overview as
corresponding window groups, e.g. in WinPCL, can be displayed
separately in the desktop. Particularly in window mode, it is otherwise
difficult to gain an overview of operating situations.

• The desktop offers openness for 3rd
 party software

MT Interfaces for MTC200

MTGUI_Oberfl.bmp

Fig. 1-3: Applications for the MTGUI system for MTC200

MT Interfaces for TRANS200

MTGUI_Oberfl_Trans.bmp

Fig. 1-4: Applications for the MTGUI system for TRANS200

The TRANS200 MTGUI system does not have a WinHMI or WinPCL
desktop.
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Application Areas for MT Interfaces (MTC200)

MTGUIDesktops_gr.bmp

(1): WinMTC, see chapt. "MTGUI Desktop"
(2): WinHMI, see chapt. "WinHMI Desktop (MTC200 Only)"
(3): WinPLC, see chapt. "WinPCL Desktop (MTC200 Only)"
(4): Project Navigator, see chapt. "General Information About Project

Navigator"
(5): Drive Top, see chapt. "DriveTop Desktop"

Fig. 1-5: Examples of desktops in the MTGUI system for MTC200

Operating Philosophy
The operation of MT interfaces in the MTGUI system offers the following
features:

• Global use of keys on all desktops (does not apply to TRANS200,
which does not have any <OP> keys)
The <OP> keys for WinHMI can also be used in the MTGUI desktop.
This means that WinHMI applications can be started from the MTGUI
desktop.

• Desktop operation via function keys

• Menu bars in the desktops

• Pop-up menus for quickly selecting menu commands
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• Global user management

• Operational support from a help system

• Access to applications via main menu

Screen Layout
The MTGUI desktop system ensures that applications have a standard
screen layout. The operating elements and their operation are identical.

The figure below shows the various areas of the MTGUI desktop. In order
to show this clearly, an application is not displayed in the application area
(4). The method for opening the application Main Menu via the View
menu item is also shown:

Desktop_leer_gr.bmp

(1): Header line
(2): Main menu bar
(3): Menu command
(4): Application window
(5): Function keys
(6): OP keys (not available for TRANS200)

Fig. 1-6: MTGUI desktop without application

The title in the header line comprises the desktop name (Indramat
MTGUI) and the name of the application.

The main menu bar contains standard menus with specific menu
commands (figure above). It is usually extended with menus and
functions for the specific application.

The individual menus (and submenus) contain menu commands which
trigger functions.

The MTGUI desktop with no application is set up for opening the main
menu (figure above).

The application runs in this area of the window. It also influences the
assignment of (1), (2), (3) and (5).

Header line (1)

Main menu bar (2)

Menu command (3)

Application window (4)
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Function keys <F2> - <F9> are used by the dialog windows of the active
application. They are used to execute functions in the application. In an
"empty" desktop, the keys do not have a function and are not labeled
(except <F1>, see figure above).

The availability of the OP keys depends on the control unit type used. The
TRANS200 control does not have any <OP> keys.

If WinHMI is installed on the control unit, the <OP> keys are linked to
WinHMI applications. It is possible to switch from applications in the
MTGUI desktop to WinHMI applications.

The <OP8> key (Programming) has a navigator function.

If an application in the HMI desktop is active, you can switch to the main
menu of the MTGUI desktop by pressing the <OP8> key.

Supported Monitor Resolutions
The MTGUI supports the screen resolutions listed below. Generally, a
proportional representation is used; the 640 x 480 screen resolution on a
10" screen is used as the basis.

Size Screen resolution

10“ 640 x 480

12“ 800 x 600

15“ 1024 x 768

Fig. 1-7: Assignment of resolution to screen size

MTGUI is configured in such a manner that it covers the entire screen,
regardless of the resolution.

WinTRANS is configured in such a manner that it uses a resolution of 640
x 480.

The WinTRANS interface can be moved and dragged using the mouse.

DriveTop supports only the resolution 640 x 480.

Function keys (5)

OP keys (6)

Special function of <OP8>

MTGUI

WinTRANS

DriveTop
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Main Menu
The applications in the desktop can be called via the main menu.

Main Menu (MTC200)

Desktop_Hauptm_gr.bmp

Fig. 1-8: Main menu for MTC200

The main menu (see Figure above) shows the menus of a maximum
expansion level for an MTC200.

The main menu can be called from all applications (excluding
DriveTop) within the MTGUI desktop system via the <PROG> key. 
Does not apply to TRANS200.

The main menu is itself an application of the MTGUI desktop.

Characteristics:

•  The main menu combines all the main application areas

• Each application can be started from the main menu

• The main menu consists of a unique display for the selected PC,
device, module and process as well as a function selection list that can
be freely selected

• If no application is active in the "control" area, the main menu is
displayed after the "Programming" OP area is selected in WinHMI.

The functions in the function selection list can be started in various ways:

1. Highlighting the desired function using the <Cursor down> and
<Cursor up> keys, then pressing
<Enter>

2. Direct selection of the selected <F> keys, such as 
Call NC Screen with:
<F7> key

3. Via menu commands in the menu bar:

• In the menu bar, press the <Alt> key to highlight a menu item, then
press the <Cursor right> key

• Use the <Cursor right> and <Cursor left> keys to select a menu

• Use the <Enter> key to open a menu window

Calling applications
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• Select a menu command with the <Cursor down> and <Cursor up>
keys

• Press <Enter> to start the menu command

Main Menu (TRANS200)

Hauptmenu_Trans_gr.bmp

Fig. 1-9: Main menu for TRANS200

The functions in the function selection list can be started in various ways:

1. Direct selection of the selected <F> keys, such as 
Call NC Screen with:
<F5> key

2. Via menu commands in the menu bar:

• In the menu bar, press the <Alt> key to highlight a menu item, then
press the <Cursor right> key

• Use the <Cursor right> and <Cursor left> keys to select a menu

• Use the <Enter> key to open a menu window

• Select a menu command with the <Cursor down> and <Cursor up>
keys

• Press <Enter> to start the menu command

Calling applications
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Single and Multiple Window Operation
The MTGUI desktop can contain several applications. Multiple window
operation enables the tracking of processes that are controlled or
monitored in different applications.

Multiple Window Operation for MTC200
In the following example, three applications are open and displayed next
to one another:

• Main Menu

• NC Screen

• Project navigator

Desktop_Mehrfenst_gr.bmp

Fig. 1-10: Multiple window operation for MTC200

The Window menu contains a list of active applications. The Tile
Vertically menu command displays these applications in the above
layout.

Multiple Window Operation for TRANS200
In the following example, three applications are open and displayed next
to one another:

• Project Navigator

• NC Screen

• Control 1 (NC Assistance)
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TransFenster_gr.bmp

Fig. 1-11: Multiple window operation for TRANS200

1.3 Starting the MT Interface

The MTGUI system must be installed on a PC with WinNT or
Windows2000.

Start for MTC200
MTC200 can be started via the icon in the Windows interface

or from the Windows Start menu:

Startmenu_gr.bmp

Fig. 1-12: Starting the MTGUI desktop for MTC200

When opened, the MTGUI desktop contains the "Main Menu (MTC200)"
as the application.

The MTGUI desktop is the framework for various applications in the
MTGUI system. The name of the application is displayed in the header
line of the desktop.
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• Main menu

 INDRAMAT MTGUI – [MAIN MENU]

• NC Screen

 INDRAMAT  MTGUI – [NC SCREEN  -  STARTUP]

• Setup menu 

 INDRAMAT MTGUI – [SETUP MENU]

• Project Navigator

 INDRAMAT MTGUI – [PROJECT NAVIGATOR]

Start for TRANS200
TRANS200 can be started via the icon in the Windows interface

or from the Windows Start menu:

Startmenu_Trans_gr.bmp

Fig. 1-13: Starting the MTGUI desktop for TRANS200

When opened, the MTGUI desktop contains the "Main Menu
(TRANS200)" as the application.
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1.4 Calling Functions

The execution of commands or functions for desktop applications can be
started in various ways:

The different call options for the Delete line command are shown in the
NC Editor:

D_Menubefehl_gr.bmp

(1): NC Editor is active, cursor in a line
(2): Edit menu \ Delete line
(3): <Ctrl>+<Shift>+<L> shortcut
(4): <F3> key: Delete Line

Fig. 1-14: Example: "Delete line" command for both MTC200 and TRANS200

(The <OP> keys are not available for TRANS200.)

Requirement: (1): In the MTGUI desktop, the NC editor has the
focus, since the last action was to highlight a line with
the cursor.

1. Executing the function from the menu bar
The Edit menu contains the Delete line menu command. 
When the command is highlighted (2), the line is deleted by pressing
<Enter>.

2. Executing the function using shortcuts
The <Ctrl>+<Shift>+<L> key combination is the shortcut for the
Delete line menu command (3). 
If this key combination is executed, the line will be deleted.

3. Executing the function using <F> keys 
The line is deleted by pressing the <F3> key (4).

4. Executing the function from the pop-up menu:
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D_Popupbefehl_gr.bmp

Fig. 1-15: Pop-up menu

In accordance with the above requirement, a pop-up menu is opened via:

• Right mouse button, or

• <Shift>+<F10> shortcut

The pop-up menu contains the Delete line menu command.

When the command is highlighted (see figure above), the line is deleted
by pressing <Enter>.

There are three ways of highlighting a menu command in a menu window:

1. The highlight in a menu is moved down with the <Cursor down> key
and up with the <Cursor up> key.

2. The so-called access keys (key combinations with the <Alt> key:
<Alt>+<2nd key>) can also highlight commands. The second key is
indicated by an underlined character in the command word. 
Example: The access keys for the Delete line command are
<Alt>+<L>

3. Mouse click

Certain functions are protected by User Management.

The functions are available only if the user has the associated
authorization, see User Management.

Note about highlighting

User management
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1.5 Standard Operation of the MTGUI Desktop

The keyboards of the MTGUI interface are shown using a BTV20.3 as an
example:

Indramat

TEMP HD POWER

,

ESC OK

4 5 6 .
SFT

1 2 3

0

DEL

ALTCTRL

INS

M9

M10

M11

M12

M13

M14

M15

M16

< F1 F10 > -
7 8 9 N +

SP

TABINFONEXT

PROG

M1

M2

M3

M4

M5

M6

M7

M8

TEMP

OPERATOR PROG

HD POWER

OK

CTRL AL

SFT

DEL

ESC

<
7

F1
8

F10
9

<
N +

-

PROG
4

-
.65

,
INS

3
TA

2
INFO

1
NEXT

0
SP

F2 F3

OP2

F4 F5 F6 F7 F8 F9

OP3 OP4 OP5 OP6 OP7 OP8 OP9

R1

R6

R8

R7

R5

R4

R3

R2

L1

L6

L8

L7

L5

L4

L3

L2

SYSTEM200 BTV20

F2 F3

OP2

F4 F5 F6 F7 F8 F9

OP3 OP4 OP5 OP6 OP7 OP8 OP9

1

3

2

4

5

5

5

OK

CTRL AL

SFT

DEL

ESC

F1 F10

PROG
4

-
.65

,
INS

3
TA

2
INFO

1
NEXT

0
SP

<
7 8 9 N +

-<

OP_Tast.FH7

(1): Overall view
(2): Keypad
(3): F key row
(4): OP key row
(5): Machine keys

Fig. 1-16: Operating keys on the BTV20.3

Keypad

BTV20 keypad => Standard keyboard Key functions of 1st level

1A
1B
1C
1D
1E
2A
2B
2C
2D
2E
3A
3B
3C
3D
3E
4A

4B
4C
4D
4E
5A
5B
5C
5D
5E
6AB
6C
6DE

<;>
<F1>
<F10>
<:>
<->
<Ctrl>+<Shift>+<Alt>+<Q>
no corresponding key
<Alt>
<Ctrl>+<F6>
<Shift>
<Ctrl>+<Shift>+<Alt>+<N>
no corresponding key
<Tab>
<Ins>
<Del>
no corresponding key

<Space>
<Cursor up>
<Ctrl>
<Alt>
<Page up>
<Cursor left>
no corresponding key
<Cursor right>
<Page down>
<Esc>
<Cursor down>
<Enter>

Semicolon
Assigned to the active application
Assigned to the active application
Colon
Minus sign
Opens the main menu
not assigned
Sets focus on the menu bar
Switches windows
<Shift> function of the standard keyboard
Switches controls in WinHMI
Calls the Information window
Switches the focus in the active application
Switches between Insert <=> Overwrite
Delete
Switch (together with 2nd

 key) to 2nd
 level

Example: Key <7> = key <1A> + key <4A>
Moves highlight downwards
Moves highlight upwards
<Ctrl> function of the standard keyboard
Sets focus in the menu bar
Moves highlight to top
Moves highlight to left
Maximize window
Moves highlight to right
Moves highlight to bottom
Removes highlight in menu bar and window
Moves highlight downwards
Activates the highlighted command

Fig. 1-17: BTV20 keypad
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Keys with a green/black diagonal division have a dual function:

• Black field: First function

• Green field: Second function

Use the <arrow> key to switch between fields:

Key on the BTV20.3 Standard keyboard Meaning

No equivalent key The second function can be triggered
by pressing the <arrow> key at the
same time.

Fig. 1-18: "Arrow key"

Calling Desktop Applications
The first function (black background) of the dually assigned keys is
described in the following table.

Key on the BTV20.3 Standard keyboard Meaning

 ... <CTRL>+<SHIFT>+<ALT>+<F2>...
<CTRL>+<SHIFT>+<ALT>+<F9>

The keys call applications (including
different desktops).

 ... <F2> - <F9> The keys are assigned to the active
application in the desktop.

 ,   <F1>, <F10> The keys are assigned to the active
application in the desktop.

<CTRL>+<SHIFT>+<ALT>+<Q> The key opens the main menu.

 ,  <ALT> The key moves the focus to the menu
bar.

<CTRL>+<F6> Switch windows.

<TAB> The key changes the focus in the
active application.

Fig. 1-19: Keys for navigation

Entering numeric values
An external keyboard is required to edit an NC program (or similar).

Numeric values can be edited with the restricted character set of the BTV
keys. It is also possible to select set numbers for an NC program (N).

The second function of the dually assigned keys is described in the
following table.

Key on the BTV20.3 Standard keyboard Meaning

     

+
       ,

...
 , 

<Arrow key>+<1> - , <9> Input of numbers <1>, ... , <9>

Dual assignment of BTV20
keyboard (MTC200)
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1.6 System Error Display

The system error display shows current system errors and current local
mechanism errors. The mechanism errors always relate to a device, e.g.
M0 indicates one or more mechanism errors in control 0, and C1
indicates a system error in control 1.

The header line of the MTGUI desktop contains the current system and
mechanism errors for all connected devices.

Systemfehler_gr.bmp

(1): System errors and mechanism errors
(2): Open the system error display with <Alt>+<F2>

Fig. 1-20: System error display

The errors are shown in an error display (1) in the MTGUI desktop (see
figure above):

• C error System error (red)

• M error Mechanism error (yellow)

The error number corresponds to the device address or control number.

The error dialog box can be opened by pressing the <Alt>+<F2> keys (2).
This is possible only if an error exists. Here the user is provided with
additional information about the displayed error code:



MTGUI User Interface Overview of Machine Tool Graphic User Interfaces 1-17

DOK-CONTRL-MTGUI***V23-AW01-EN-P

Systemfehler1_gr.bmp

Fig. 1-21: System error display dialog box

The columns in the table contain the following information:

• Error type

• Device or device name

• Short description of the error

• Time the error occurred

Additional information (if available) is displayed when the error is
highlighted in the table:

Systemfehler2_gr.bmp

Fig. 1-22: Additional error description

<Alt>+<F2>
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1.7  Header

Information about the control selected in the control selection and about
the process is displayed in the header above the application area.

Header_Hauptmenu_gr.bmp

Fig. 1-23: Main menu with header

The appearance of the header depends on the type of control selected
and can be configured separately for every type.

The following headers, which are adapted to the corresponding control
type, are available:

Header_MTC_1_gr.bmp

Fig. 1-24: MTC_Header_1

Header_MTC_2_gr.bmp

Fig. 1-25: MTC_Header_2

Header_MTC_3_gr.bmp

Fig. 1-26: MTC_Header_3

Header_MTA_gr.bmp

Fig. 1-27: MTA_Header

Predefined headers
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Header_TRANS_2_gr.bmp

Fig. 1-28: TRANS_Header_2

Header_ISP_gr.bmp

Fig. 1-29: HMI_Header

The connection status is indicated by a bitmap in the top right corner of
the header. Three states are possible:

Online Control is in online mode
Communication is possible

Offline Control is in offline mode

Connection Interruption Control is in online mode
Communication is interrupted

Fig. 1-30: Connection status bitmaps

The control number and the process number, separated by a period (0.0),
are displayed in headers "MTC_Header_2" and "MTC_Header_3".

The NC notes of the MTA are displayed in the user-defined area of the
MTA_Header.

The header that is displayed depends on the control type. The following
assignment applies:

• MTC200: MTC_Header_2

• TRANS200: TRANS_Header_2

• MTA200: MTA_Header

• ISP200: HMI_Header

• MTVNC: MTC_Header_2

If another control type is now selected from the control selection, the
header that is displayed also changes.

The header can be edited only with the NC screen of the MTC. The
header can not be configured for TRANS, ISP and MTA. For further
information on editing the header, see the description "NC Screen",
section "Configuration of NC Screen and Header".

Connection status

Control number

MTA header

Assignment of the control type
header

Editing the header
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1.8 Offline Operation

Offline operation is required mainly in the program development and
commissioning phases of the machine, less often in the production phase
of the machine.

Offline operation permits certain interface functions to be used without
requiring a control unit.

• Creating and editing user data such as NC programs, I/O
configuration, etc.

• Designing and configuring interface functions.

Note: For this, a parameter record must be active. The parameter
record provides the axes, limit values, etc. that are required for
the machine.

When the control unit is switched to offline operation, the communication
to the control unit is switched off. States and data from the control are no
longer displayed. Only selected functions are still available.

The control unit selector is used to switch between online and offline
operation.

In offline operation, there is an error message with No. 2011651159.

In offline operation, the data records that were last preselected or active
are indicated by dimmed CNC symbols.

• Dimmed CNC symbols in the tree and list of the Project Navigator, e.g.
for the active parameter record.

• Dimmed CNC symbols in the editors for indicating the online files for
offsets, NC variables, NC events and D corrections.

1.9 Language Switching

See chapt. "Setup Menu: Language Selection" in "Setup Menu".

1.10 Connection Interruption

An interrupted connection is an erroneous state. This state occurs when
the control is disconnected from the interface in online operation, e.g.
when the serial connection to the PC is connected in the case of a RECO
control unit.

When a connection is interrupted, there is no communication between the
control and the interface. States and data from the control are no longer
updated or displayed. Only selected functions are still available.

System error No. xxx exists in the case of a connection interruption.

When a connection is interrupted, the data records that were last
preselected or active are indicated by dimmed CNC symbols. Also see
Offline Operation.

Characteristics of offline
operation

Switching

Identification of offline operation

Features

Indication of the connection
interruption
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There are two procedures for this:

• Direct elimination of the cause of the error:

• After the cause of the error has been eliminated, the interface
automatically reconnects to the control.

• Use of offline operation for elimination

• Switch the control to offline operation.

• Eliminate the cause of the error.

• Switch the control to online operation.

Elimination of the connection
interruption
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2 Applications in the MT Interface

2.1 MTGUI Desktop

The MTGUI desktop is the central desktop for MTC200 and TRANS200.
The following applications run in the MTGUI desktop:

• Main Menu

• Control Selection (adapted)

• NC Screen

• Project Navigator

• Setup Menu

Main Menu (MTC200)
The main menu is displayed after the MTGUI desktop is started:

MTC_Menu_gr.bmp

Fig. 2-1: Main menu for MTC200 with the View menu

In the Figure above, the View menu is open. It contains the following
menu commands:

• Main Menu (always visible as a command)

• Project Navigator (only available if it is not open)
or special call commands for the Navigator (if it is already open)

Both applications are used for navigation in the MT interface (see chapt.
"Navigating Within the MTGUI Desktop"). Additional applications can be
called via the main menu:

• The main menu window by highlighting the application + pressing
<Enter>

• <F> keys or shortcuts

• Menu commands from the menus in the menu bar
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Highlighted
application +

<Enter>

Key or
shortcut

Menu \ menu command

Control Selection <F2> Control \ Control selection

Configuration <F3> Startup \ Configuration

WinHMI <F5> Control unit \ WinHMI (in the WinHMI
desktop)

NC Screen <F7> Control unit \ NC screen

WinPCL <F8> Startup \ WinPCL (in the WinPCL
desktop)

Start Setup <Shift>+<F2> Startup \ Setup

Project navigator View \ Project Navigator

Exit <Alt>+<F4> File \ Exit

 key View \ Main Menu:
Function: Back to main menu

File \ Log on user
(see Start Setup / User management)

File \ Log off user ( " )

File \ Change password ( " )

File \ Log on with name and
password ( " )

File / Log on with reference and
keycode ( " )

Fig. 2-2: Opening applications via the main menu for MTC200

Main Menu (TRANS200)

Trans_Menu_gr.bmp

Fig. 2-3: Main menu for TRANS200 with the View menu

In the Figure above, the View menu is open. It contains the following
menu commands:

• Main Menu (always visible as a command)

• Project Navigator (only available if it is not open)
or special call commands for the Navigator (if it is already open)
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Both applications are used for navigation in the MT interface (see section
"Navigating in the MT Interface"). Additional applications can be called via
the main menu:

• <F> keys or shortcuts

• Menu commands from the menus in the menu bar

Application Key or
shortcut

Menu \ menu command

Control selection <F2> Device \ Control selection

Configuration <F3> Startup \ Configuration

NC Program <F4> Startup \ NC Programs

NC Screen <F5> Online prg. \ NC Screen

Watch+Force <F6> Online prg. \ Watch+Force

Control Functions <F7> Online prg. \ Control functions

I/O Configuration <F8> Startup \ I/O Config.

Exit WinTrans <F9>
<Alt>+<F4>

File \ Exit

Start Setup <Shift>+<F2> Startup \ Setup

Project navigator View \ Project Navigator

Main Menu View \ Main Menu

Fig. 2-4: Opening applications via the main menu for TRANS200

Control Selection (MTC200)
Control selection is a special application which can be used by both the
MTGUI desktop and (in a slightly different configuration) the HMI desktop.
See also the WinHMI description.

Control selection is used to select a control from the available controls.
The machine tool interface that appears on the screen is then always
based on the selected control.
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Steuerungsauswahl_gr.bmp

Fig. 2-5: Control selection for MTC200

The first list displays all configured controls and contains the following
columns:

• K: The head-end control is indicated by an X.

• L: An X indicates local control; a blank entry indicates remote control

• Control Name: Device name

• Status: Device status:
OK, System failure, Download, Failure, No connection

Controls that cannot be selected, e.g. due to an error, are displayed in
italics. The selected control is highlighted in bold print. All other control
are displayed in normal print.

The second list shows the processes of the highlighted control. The list
contains two columns:

• Process name

• Status (OK, Failure)

The currently selected process is displayed in bold.

The highlighted control and the highlighted process are selected when the
user presses OK. The dialog box is closed. The selected control can then
be further processed.

The <Info...> button opens another modal dialog box, which provides
information about the highlighted control.

The information includes the following:

Controls

Processes

Info...
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a_steuerausw_info.bmp

Fig. 2-6: Information about the selected control

• Number of the PC to which the control is assigned

• Local device address

• Device type

• FarDevice address

Switching Online/Offline (MTC200)
The ON <-> OFF button is used to switch between online and offline
operation (see Fig. in "Control Selection (MTC200)").

Depending on the current state of the marked control, it can be switched
to offline or online operation. Information regarding the switch is provided
in a message box; in addition, the switch can be cancelled here. The
status of the selected control is updated as soon as the control responds.

The control is switched to offline operation. States and data from the
control are no longer displayed. Only selected functions are still available.
Communication to the control is switched off.

Control unit XYZ highlighted in the Control Selection window is switched
to online operation. Beforehand, ensure that communication with the
control is possible.

Switching the control between online and offline operation is password-
protected in User Management. The right "Switch to online/offline
operation" is located in the "General" tab in User Management.

Only local controls can be switched between online and offline operation.

Remote control that are in offline operation can not be selected in Control
selection.

Switching to offline operation

Switching to online operation

Switching protection
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Control Selection (TRANS200)
The Control selection menu item is called with the <F2> key. It
corresponds to Control selection for the MTC200 but is more limited, in
that processes cannot be selected (only one process per control).

Steuerungsauswahl_T_gr.bmp

Fig. 2-7: Control selection for TRANS200

See "Control Selection (MTC200)".

Project Navigator
A detailed description of the Project Navigator can be found in the
"General" section.

In the main menu, the <F3> key opens the Configuration tab in the
Project Navigator application. The various control configurations can be
carried out here.

ProjectNavigatorConfig_gr.bmp

Fig. 2-8: Project Navigator with the "Configuration" tab
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NC Screen
A detailed description can be found in the description of the NC Screen
application.

NC Screen is used to display important data for the control unit. The user
is therefore provided with a quick overview of the current status of the
control and the machine.

With MTC, it is possible to integrate windows with status indicators and
windows for displaying and editing NC data into an NC screen.

The display refers to the control and process selected in dialog box
"Control Selection" (main menu).

The address and name of the control are displayed in the header.

NC-Bildschirm_gr.bmp

Fig. 2-9: MTGUI desktop with NC Screen

Setup Menu
Various applications which can be used to specify basic settings for the
control can be called from the Setup menu.

The Setup menu can be called with the <Shift>+<F2> shortcut for both
the MTC200 and TRANS200. The specific differences between these
control types are covered in the documentation for the special application
programs.
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SetupMenue_gr.bmp

Fig. 2-10: Setup menu

Setup Menu: Firmware Management
A detailed description can be found in the documentation "Setup".

Bosch Rexroth control components are equipped with electrically erasable
flash memories. Replacing EPROM chips is not necessary to install or
update the firmware. Instead, the firmware is simply loaded on the PC.

Setup Menu: User Management
A detailed description can be found in the documentation "Setup".

User Management ensures that only authorized personnel have access to
protected functions (and program parts). Before a protected function is
executed, the user must register with User Management.

Setup Menu: Remote PG Setup
A detailed description can be found in the documentation "Setup".

The PG interface is a performance feature which, in conjunction with the
appropriate client software, enables remote programming of the PLC.
With the aid of this add-on, the user can allow or prevent remote
programming of the PLC for this computer.

Setup Menu: Teleservice Setup
A detailed description can be found in the documentation "Setup".

The TS interface is a performance feature which, in conjunction with the
appropriate client software, enables remote operation of the computer.
With the aid of this add-on, the user can allow or prevent remote
operation of this computer.

Setup Menu: Message Integrator
A detailed description can be found in the documentation "Setup".

Diagnostic message handling includes:

• processing of process messages and system faults

• processing of general PLC and sequencer errors.

General PLC and sequencer errors are processed using the external
Message Integrator application, which is available in Version 18 or later.



MTGUI User Interface Applications in the MT Interface 2-9

DOK-CONTRL-MTGUI***V23-AW01-EN-P

Dialog boxes for processing process messages and system faults are
already integrated in the MTGUI.

The Message Integrator dialog boxes that are currently integrated in the
MTGUI enable the user to:

• modify process messages and system faults specified by Bosch
Rexroth with the relevant additional information

• add user-created process messages and system faults.

See Message Integrator (Messagesint_de.hlp).

Setup Menu: Backup
This menu is used to save control unit data.

A detailed description can be found in the documentation "System
Services".

Setup Menu: Restore
This menu is used to restore control data.

A detailed description can be found in the documentation "System
Services".

Setup Menu: Email Configuration
The email connection allows event-driven sending of messages, such as
maintenance instructions or fault messages, via email, SMS or fax to
various devices such as a PC, cell phone or pager.

A detailed description can be found in the documentation "System
Services".

Setup Menu: License Management
The License Management System (LMS) manages licensing of the
standard range of functions of the MTGUI as well as the enablement of
certain additional components (= options).

A detailed description can be found in the documentation "System
Services".

Setup Menu: Language Selection

Sprachumschaltung_gr.bmp

Fig. 2-11: Switching languages
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Key <F2> is used to switch the set language.

In the example (see Fig. above), a switch from the current language
(English) to the German language setting can be made.

1. Press <F2>.
The label of <F2> changes.

2. Exit the setting dialog box with <F9>.
3. Exit the MTGUI desktop.

Note: The new language goes into effect when the MTGUI interface
is restarted.

2.2 WinHMI Desktop (MTC200 Only)

The WinHMI desktop is not available for the TRANS200.

A detailed description can be found in the WinHMI description.

HMI_gr.bmp

Fig. 2-12: WinHMI desktop with machine overview

The applications in the WinHMI desktop are described in DOK-MTC200-
WIN-HMI*V19-AW01-EN-P (288996).
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2.3 WinPCL Desktop (MTC200 Only)

The WinPCL desktop is not available for the TRANS200.

PCL_gr.bmp

Fig. 2-13: WinPCL desktop with action window

The applications in the WINPCL desktop are described in 
DOC-CONTRL-WINPCL*3VRS-AW01-EN-P (291135).

2.4 DriveTop Desktop

The Drivetop desktop is used by the MTC200 and TRANS200.

DriveTop_gr.bmp

Fig. 2-14: DriveTop desktop with mechanical gear dialog box

The functions of DriveTop are used to configure drive parameters and to
commission the drives.
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3 Navigating in the MT Interface

3.1 Desktop Selection from the Main Menu (MTC200)

The desktop is changed by switching tasks in the Windows system.

Taskwechsel1_gr.bmp

Fig. 3-1: Navigating between desktops

The figure (above) shows how to access the applications in the various
desktops from the main menu (MTGUI desktop) for MTC200.

The NC-specific functions (e.g. NC Screen) and the Project Navigator are
applications in the MTGUI desktop.

Use <F5> to access HMI.

Use <F8> to call PCL.
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To access DriveTop, call the configuration in the Project Navigator with
<F2>. DriveTop is opened by selecting the SERCOS drive parameters
and pressing <Enter>.

To return to the applications in the MTGUI desktop, press the <PROG>
key on the BTV20 (not DriveTop) or switch tasks using the <Alt>+<Tab>
key combination.

3.2 Changing Desktops Using Project Navigator

Project Navigator can also be used to change between the MTGUI
desktop (referred to here as NC) and the PCL desktop (referred to as
PLC).

First, Project Navigator must be opened via the main menu either by
highlighting "Project Navigator" and pressing <Enter> or via the
View/Project Navigator menu command.

ProNavNCSPS.bmp

 MTGUI desktop     WinPCL desktop
Fig. 3-2: Switching tasks using Project Navigator

The PLC can be called from Project Navigator (MTGUI desktop contents).

The NC can be called from Project Navigator (WinPCL desktop contents).
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3.3 Navigating Within the MTGUI Desktop

Open desktop applications can be activated via the Window menu.

ProNavFenster_gr.bmp

Fig. 3-3: Open applications in the MTGUI desktop

In the figure above, the applications in the MTGUI desktop are displayed
next to one another (Tile Vertically menu command). The following
applications are open:

• Project navigator

• NC Screen - Startup

• NC Editor (control unit 0.0 with NC Program Test1)

Press button  to maximize the window size of the corresponding
application.

The applications can be selected via the Window menu.
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ProNavFensterMax_gr.bmp

Fig. 3-4: Window menu in the MTGUI desktop

The <F> keys are assigned by the active application.

1. figure: Active application: NC Editor Editor keys

2. figure: Active application: NC Screen NC Screen keys

Note on the <F> key bar
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4 Project Navigator

4.1 General Information About Project Navigator

Project Navigator is a tool used for navigation in the diverse data of all the
configured controls of a PC. For this purpose it offers:

• different instances (window layout) and views (structure of the data)

• command input via the main menu, contextual menu and function
keys

• specific access to online and offline data

• specific programmer and user actions for each data type

• standard functions such as New, Edit (calling an editor), Download
(loading to the control), etc.

Instances
In the "Tree+List" instance, a tree structure is displayed on the left-hand
side of the window and a list on the right-hand side, which displays
additional information about the highlighted entry, if available. The figure
below is an example of this instance:

ProjectNavigatorMenu_gr.bmp

Fig. 4-1: Project Navigator in the "Tree+List" instance

In the "List" instance, only a list is displayed. This display is used, for
example, when only one selection is to be made within a data type
specified by a different application. The figure below is an example of this
instance:

Tree+List

List
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ProjectNavigatorList_gr.bmp

Fig. 4-2: Project Navigator in the "List" instance

Only the tree structure is visible in the "Tree" instance. At present this
display can only be activated via the "View\Tree" menu item. This is
useful if the main purpose is viewing the hierarchy when detailed
information is not necessary.

Call and Exit
Project Navigator can be called either in the main menu of the user
interface by selecting "Configuration" or "Project Navigator" or indirectly
from the NC Screen or the various NC Editors in the "List" instance.

Project Navigator can be closed at any time via the <F9> function key
(Exit Navigator), using the Close button or the <Ctrl>+<F4> shortcut or via
the "File\Exit Navigator" menu item.

The "Window" menu item or the <Ctrl>+<F6> shortcut can be used to
switch to another window/application without exiting Project Navigator.

Views
Project Navigator offers the user three different views of the control data
using various tree structures. The three views are displayed in the
"Tree+List" and "Tree" instances as tabs. To switch views, click the tab of
the desired view or select the corresponding entry in the "View" menu
item.

When the input focus is in the tree, the view can be switched using the
standard Windows function <Ctrl>+<Tab> (forward) or
<Shift>+<Ctrl>+<Tab> (back).

Tree

Call

Exit

Switching to other applications
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View: Structure
 The figure below shows Project Navigator in Structure view:

ProjectNavigatorStructure_gr.bmp

Fig. 4-3: Project Navigator in Structure view

Structure view displays all the configured control units in the first level of
the tree. The node designation (entries in trees are also called "nodes")
consists of the address and the name. In the case of control units with the
status "Offline", "(offline)" is also displayed and the node designation is
dimmed. Controls that do not currently have a connection are also
dimmed.

Note: The order in which the controls are displayed in Project
Navigator is the same as in the system configurator and can
only be modified there.

The appearance of an extended tree structure below the relevant control
node depends on the control type and the configuration defined in the
active parameter set.

In addition, the tree structure for the MTC200 control family depends on
the module configuration specified in the "ModulDef.ini" file. This file
specifies whether modules exist and which configured processes are
assigned to them. The corresponding module nodes are displayed with
subprocess nodes accordingly.

Specific entries which represent the relevant control unit data for the
process or device are displayed for each control type. If a plus or minus
symbol appears on the left of the entry, this means that the data is further
structured; otherwise the entry is an end node. In this case, additional
information is usually displayed in the list, as shown in the figure below.
Certain end nodes (e.g. the "PLC", "NC Screen" or "Parameter" entries)
offer only one command, which is triggered with the Enter key or by
double-clicking the mouse, and enables the user to switch to the desired
application.

The "Cycle library" entry also appears below the control nodes when at
least one control from the MTC200 control familiy is configured (only this
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control type has cycles and thus a cycle library). This is a special entry as
it is not directly related to a control.

View: Data
The figure below is an example of Project Navigator in the "Tree+List"
instance in Data view:

ProjectNavigatorData_gr.bmp

Fig. 4-4: Project Navigator in Data view

In contrast to Structure view, which offers control-oriented display of the
data, the different data types are in the foreground in Data view.

All data types that support the current configured control are displayed in
Data view. The relevant control offered by a data type are listed within the
particular data type. With regard to process-related data, the current
configured processes for an MTC200 control are also displayed.

For some nodes (e.g. "Tool Management" or "Cycle library") that are not
directly related to a control, no control nodes are displayed.

As in Structure view, the "PLC" end node, which only appears if at least
one control is configured with a PLC, can be used to switch to WinPCL
via the Enter key or by double-clicking the mouse.

Since the control data are displayed according to data type, the user is
provided with an overview and faster access to these data.
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View: Configuration
The figure below is an example of Project Navigator in Configuration view:

ProjectNavigatorConfig_gr.bmp

Fig. 4-5: Project Navigator in Configuration view

Configuration view has a similar layout to Structure view; however, only
controls that have machine parameters (MTC200, TRANS200, MTA200,
MTVNC control types) and machine data (MTC200, MTVNC control
types) are displayed in Configuration view. Only the "Machine
Parameters" entry with its special structure, which is explained in more
detail in the chapter about machine parameters and machine data,
appears under the relevant control node.

Configuration view plays an important role in the configuration of control
units, as it is only in this view that parameter sets can be created,
modified and loaded in the appropriate control. The active parameter set
of a control also influences the display in the other two views, as it
determines which processes are defined and what they are called.
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Control Unit-Specific Representation
As discussed in the previous section, the entries and information
displayed in Project Navigator depend on the configured controls, their
type and the active machine parameter set for MTC200, TRANS200 and
MTVNC control types.

The nodes that are used for various control types in the "Structure" and
"Data" views are described in the following table:

Node type
(see figures)

Control type Description

<Control node> <All> Represents a configured control unit and consists of address and name; in case
of control units with status "Offline", "(offline)" is also displayed

PLC MTC200
ISP200

End node which acts as a switch and can be used to switch to WinPCL

<Module 1-99> MTC200
MTVNC

Structuring element that appears in Structure view for each configured module
directly below the relevant control node

<Process 0-6> MTC200
MTVNC

Represents the relevant process with its process-specific data. Appears below
the module node when the process is assigned to the module; otherwise it is
displayed directly below the control node. This entry is not available for
TRANS200, as there is only one process.

NC Screen MTC200
TRANS200
MTVNC

End node which acts as a switch and can be used to call the NC screen with the
corresponding process for the relevant control

NC programs MTC200
TRANS200
MTVNC

Represents free NC programs. Selecting this entry in Structure view displays the
free NC programs for the relevant process in the list. In Data view for:
MTC: the relevant process must be highlighted for the desired control
TRANS: the desired control must be highlighted

Current Tool List MTC200
MTVNC

Represents the online tool list; when the entry is selected, the current tool list of
the corresponding process is displayed in the list

Tool Management MTC200
MTVNC

Root node for Tool Management. In Structure view, only the tool data for the
relevant process/relevant control is offered, whereas in Data view only data for
Tool Management can be accessed.

Zero Points MTC200
TRANS200
MTVNC

Represents offset files. Selecting this entry in Structure view displays the offset
files for the relevant process in the list. In Data view for:
MTC: the relevant process must be highlighted for the desired control
TRANS: the desired control must be highlighted

D corrections MTC200
TRANS200
MTVNC

Represents D correction lists. Selecting this entry in Structure view displays D
correction lists for the relevant process in the list. In Data view for:
MTC: the relevant process must be highlighted for the desired control
TRANS: the desired control must be highlighted

Ext. mechanism MTC200
MTVNC

Structuring element that comprises all the external mechanisms of the control
(process numbers greater than 6) in Structure view

NC program
packages

MTC200
MTVNC

Structuring element that comprises NC program packages; they are displayed in
the list and as subentries of the node

Cycle packages MTC200
MTVNC

Structuring element that comprises the cycle packages. They are displayed in the
list and as subentries of the node

NC variables MTC200
TRANS200
MTVNC

Represents the NC variable lists. Selecting this entry in Structure view displays
the NC variable lists for the relevant control in the list. In Data view, the desired
control must also be highlighted.

NC events MTC200
TRANS200
MTVNC

Represents the NC event lists. Selecting this entry in Structure view displays the
NC event lists for the relevant control in the list. In Data view, the desired control
must also be highlighted.

Machine data MTC200
MTVNC

Structuring element that comprises the machine parameter sets. They are
displayed in the list and as subentries of the node. They also provide access to
the user machine data that was loaded in the relevant control.
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Node type
(see figures)

Control type Description

Parameter MTC200
TRANS200
MTVNC

End node which acts as a switch and can be used to switch to Configuration view

Cycle library MTC200
MTVNC

Structuring element that comprises various cycle libraries (Indramat, OEM and
user cycles). They are displayed in the list and as subentries of the node

I/O Configuration TRANS200 Represents the I/O configuration lists. Selecting the entry in Structure view
displays the I/O configuration lists for the relevant control unit in the list. In Data
view, the desired control must also be highlighted.

Control Panel TRANS200 Entry which offers commands for starting the "Jogging Axis" and "Operation
Panel" applications

Fig. 4-6: Control-specific tree entries and their meaning

Offline Operation
"Offline operation" allows configuration even without a real control, i.e.

• creating/modifying/"activating" machine parameter sets

• writing/adapting PLC programs

• executing NC programming (cycles, NC programs, etc.)

• creating/modifying tools and tool lists

To do this, it is merely required that the corresponding control unit be
created in the system configurator and receives the status "Offline".
Furthermore, the status of a configured control can be switched at any
time in the Control Selection dialog box of the user interface.

After the download (which is carried out internally only) of a machine
parameter set, the parameterized processes of this parameter set appear
in the Structure and Data views, so that the process-dependent control
data can continue to be configured.

Control units with the status "Offline" are identified in the Project navigator
by the extension "(offline)" behind the name of the control unit. In addition,
the corresponding node designation is dimmed in this case or if the
connection to a control is interrupted.

As opposed to online operation, where the data that are currently in the
control are identified by red bitmaps and symbols, these bitmaps and
symbols are dimmed in offline operation. This also applies to some
upload/download bitmaps on the function key bar.

If the real control is available, its status can be set to "Online"; then the
various control data (starting with the machine parameters) can be
downloaded – the bitmaps and symbols are displayed in red.

4.2 Operation

This section describes the various ways of operating Project Navigator in
more detail.

Each individual entry in the Project Navigator tree and list usually has its
own contextual menu and individually assigned function keys and menu
bar. Consequently, when switching between tree and list or selecting
another entry, the assignment of the function keys and the instance of the
menu bar changes.

If an entry has its own contextual menu, it can be displayed by pressing
the right mouse button or <Shift>+<F10>.

The user can highlight an entry in the contextual menu in the usual way,
i.e. with the mouse, cursor keys, or by entering the underlined or first
character of the entry and then pressing Enter or double-clicking.

Contextual menu
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Pressing the <Esc> key or clicking outside the contextual menu with the
mouse closes the menu without executing an action.

As previously discussed, the menu bar contains individual items for the
entry that is focussed in Project Navigator. The entries can then be
selected and activated in the same way as in the context menu by using
the mouse or by pressing <F10> or <Alt>+<character> (<Alt>+underlined
character in the menu bar).

The function key bar can be found at the bottom of the user interface and
is displayed in the form of softkeys, which represent function keys <F2> to
<F9>. The softkeys can be triggered by clicking with the left mouse button
or by pressing the corresponding function key. As previously discussed,
the individual softkeys are assigned according to the entry that is
focussed in Project Navigator.

Switching Between Tree and List
The user can switch the input focus between tree and list by pressing the
<Tab> key or by selecting the desired entry with the mouse. This is
important, as any input via the keyboard is always applied to the entry that
has the focus. If the user wishes to navigate in the list and the focus is in
the tree, the focus can be moved to the list by simply pressing the <Tab>
key. Pressing the <Tab> key again moves the focus back to the
highlighted tree entry.

Navigation in the Tree
Both the keyboard and mouse can be used to navigate in the tree. The
mouse can be used to directly click individual entries to highlight them. To
open or close an entry, click the plus or minus symbol on the left of the
entry or double-click the entry itself.

Note: If the contextual menu for a node has a default entry, double-
clicking with the mouse executes the entry instead of opening
or closing the node. The default entry is indicated in the
contextual menu by a star before the entry.

When navigating with the keyboard, the <Cursor right> key is used to
open the current highlighted entry and the <Cursor left> key is used to
close it.

In addition, entries can be directly accessed by entering the first character
of the node name. In case of ambiguity, the next corresponding entry is
selected.

The <Page up>, <Page down>, <Home> and <End> keys can be used in
the usual way to move one page up or down or to jump to the first or last
entry in the tree.

The cursor keys, as well as the <Page up> and <Page down> keys, are
used together with <Ctrl> to move the visible section of the tree without
changing the selection.

Pressing the <Backspace> key moves the highlight to a higher-level entry,
if one exists.

Menu bar

Function key bar
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Navigation in the List
Entries are highlighted in the list by pressing the <Cursor up> and
<Cursor down> keys or by clicking once with the mouse, whereas using
the <Cursor left> and <Cursor right> keys moves the section of the list left
or right. Press the Enter key or double-click the mouse to trigger the
default command for the current highlighted entry. If this command does
not exist, the list changes to display the subentries of the highlighted
entry, if they exist. As in the tree display, pressing the <Backspace> key
moves the focus up one level if a list display is available.

If multiple selection is permitted for the displayed List entries, all the
entries can be highlighted by pressing <Ctrl>+<A>. Furthermore, it is then
possible to select/deselect groups of entries or several individual entries
using the <Shift> and <Ctrl> keys in the normal manner.

The <Page up>, <Page down>, <Home> and <End> keys can be used in
the usual way to move the screen up or down or to jump to the first or last
entry in the list.

For instances "Tree+List" and "List", there are two different degrees of
detail in the List representation; these are selected automatically.
However, if the list is wider than 400 pixels, the highest degree of detail is
always used.

The columns displayed in each degree of detail are preset for each data
type; however individual columns can be "hidden" by moving the columns
closely together with the mouse. When this list type is displayed again,
the column is displayed at the minimum width so that the user is aware
that the column is hidden. However, columns that are invisible by default
for a degree of detail can be "pulled out" by moving the mouse from the
right over the corresponding column separator and pulling the column to
the right while pressing and holding the left mouse button.

The column and the direction of the sort can only be changed with the
mouse by clicking the appropriate column header one or more times. A
small triangle then marks the current sorting column and indicates the
selected sort direction; the point of the triangle shows the direction of
increasing values.

Project Navigator saves the column width, the sorting column and the
direction of the sort for each degree of detail and each list type. These
data are saved to the hard disk when the view is changed or when Project
Navigator is closed and exited.

When key combination <Shift>+<Home> is pressed when the entry focus
is located in the list, the specified default values for the column
configuration can be reset for the currently active list type and the
currently visible degree of detail.

Note: Information about column widths and sorting can be found in
the "PRONAV.INI" file in the
"..\project_000\customdata\resource" directory. If the default
values need to be reset or in the event of general problems
with the list display, this file can be safely deleted once the
user interface has been exited.
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6 Service & Support

6.1 Helpdesk

Unser Kundendienst-Helpdesk im Hauptwerk Lohr
am Main steht Ihnen mit Rat und Tat zur Seite.
Sie erreichen uns

Our service helpdesk at our headquarters in Lohr am
Main, Germany can assist you in all kinds of inquiries.
Contact us

- telefonisch - by phone: 49 (0) 9352 40 50 60
über Service Call Entry Center Mo-Fr   07:00-18:00
- via Service Call Entry Center Mo-Fr 7:00 am - 6:00 pm

- per Fax - by fax: +49 (0) 9352 40 49 41

- per e-Mail - by e-mail: service.svc@boschrexroth.de

6.2 Service-Hotline

Außerhalb der Helpdesk-Zeiten ist der Service
direkt ansprechbar unter

After helpdesk hours, contact our service
department directly at

+49 (0) 171 333 88 26

oder - or +49 (0) 172 660 04 06

6.3 Internet

Unter www.boschrexroth.com finden Sie
ergänzende Hinweise zu Service, Reparatur und
Training sowie die aktuellen Adressen *) unserer
auf den folgenden Seiten aufgeführten Vertriebs-
und Servicebüros.

Verkaufsniederlassungen

Niederlassungen mit Kundendienst

Außerhalb Deutschlands nehmen Sie bitte zuerst Kontakt mit
unserem für Sie nächstgelegenen Ansprechpartner auf.

*) Die Angaben in der vorliegenden Dokumentation können
seit Drucklegung überholt sein.

At www.boschrexroth.com you may find
additional notes about service, repairs and training
in the Internet, as well as the actual addresses *)
of our sales- and service facilities figuring on the
following pages.

sales agencies

offices providing service

Please contact our sales / service office in your area first.

*) Data in the present documentation may have become
obsolete since printing.

6.4 Vor der Kontaktaufnahme... - Before contacting us...

Wir können Ihnen schnell und effizient helfen wenn
Sie folgende Informationen bereithalten:

1. detaillierte Beschreibung der Störung und der
Umstände.

2. Angaben auf dem Typenschild der
betreffenden Produkte, insbesondere
Typenschlüssel und Seriennummern.

3. Tel.-/Faxnummern und e-Mail-Adresse, unter
denen Sie für Rückfragen zu erreichen sind.

For quick and efficient help, please have the
following information ready:

1. Detailed description of the failure and
circumstances.

2. Information on the type plate of the affected
products, especially type codes and serial
numbers.

3. Your phone/fax numbers and e-mail address,
so we can contact you in case of questions.
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6.5 Kundenbetreuungsstellen - Sales & Service Facilities

Deutschland – Germany vom Ausland: (0) nach Landeskennziffer weglassen!
from abroad: don’t dial (0) after country code!

Vertriebsgebiet Mitte
 Germany Centre

Bosch Rexroth AG
Bgm.-Dr.-Nebel-Str. 2 / Postf. 1357
97816 Lohr am Main / 97803 Lohr

Kompetenz-Zentrum Europa

Tel.: +49 (0)9352 40-0
Fax: +49 (0)9352 40-4885

S E R V I C E

C A L L  E N T R Y  C E N T E R
MO – FR

von 07:00 - 18:00 Uhr

from 7 am – 6 pm

Tel. +49 (0) 9352 40 50 60
service.svc@boschrexroth.de

S E R V I C E

H O T L IN E
MO – FR

von 17:00 - 07:00 Uhr
from 5 pm - 7 am

+ SA / SO
Tel.: +49 (0)172 660 04 06

o d er  /  or
Tel.: +49 (0)171 333 88 26

S E R V I C E

ERSATZTEILE / SPARES
verlängerte Ansprechzeit
- extended office time -

♦ nur an Werktagen
- only on working days -

♦ von 07:00 - 18:00 Uhr
- from 7 am - 6 pm  -

Tel. +49 (0) 9352 40 42 22

Vertriebsgebiet Süd
 Germany South

Bosch Rexroth AG
Landshuter Allee 8-10
80637 München

Tel.: +49 (0)89 127 14-0
Fax: +49 (0)89 127 14-490

Vertriebsgebiet West
 Germany West

Bosch Rexroth AG
Regionalzentrum West
Borsigstrasse 15
40880 Ratingen

Tel.: +49 (0)2102 409-0
Fax: +49 (0)2102 409-406

+49 (0)2102 409-430

Gebiet Südwest
 Germany South-West

Bosch Rexroth AG
Service-Regionalzentrum Süd-West
Siemensstr.1
70736 Fellbach

Tel.: +49 (0)711 51046–0
Fax: +49 (0)711 51046–248

Vertriebsgebiet Nord
 Germany North

Bosch Rexroth AG
Walsroder Str. 93
30853 Langenhagen

Tel.: +49 (0) 511 72 66 57-0
Service: +49 (0) 511 72 66 57-256
Fax: +49 (0) 511 72 66 57-93
Service: +49 (0) 511 72 66 57-95

Vertriebsgebiet Mitte
 Germany Centre

Bosch Rexroth AG
Regionalzentrum Mitte
Waldecker Straße 13
64546 Mörfelden-Walldorf

Tel.: +49 (0) 61 05 702-3
Fax: +49 (0) 61 05 702-444

Vertriebsgebiet Ost
 Germany East

Bosch Rexroth AG
Beckerstraße 31
09120 Chemnitz

Tel.: +49 (0)371 35 55-0
Fax: +49 (0)371 35 55-333

Vertriebsgebiet Ost
 Germany East

Bosch Rexroth AG
Regionalzentrum Ost
Walter-Köhn-Str. 4d
04356 Leipzig

Tel.: +49 (0)341 25 61-0
Fax: +49 (0)341 25 61-111
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Europa (West) - Europe (West)

vom Ausland: (0) nach Landeskennziffer weglassen, Italien: 0 nach Landeskennziffer mitwählen
from abroad:    don’t dial (0) after country code, Italy:    dial 0 after country code

Austria - Österreich

Bosch Rexroth GmbH
Electric Drives & Controls

Tel.: +43 (0)1 985 25 40
Fax: +43 (0)1 985 25 40-93

Austria – Österreich

Bosch Rexroth GmbH
Electric Drives & Controls
Industriepark 18
4061 Pasching

Tel.: +43 (0)7221 605-0
Fax: +43 (0)7221 605-21

Belgium - Belgien

Bosch Rexroth AG
Electric Drives & Controls
Industrielaan 8
1740 Ternat
Tel.: +32 (0)2 5830719
- service: +32 (0)2 5830717
Fax: +32 (0)2 5830731
 service@boschrexroth.be

Denmark - Dänemark

BEC A/S
Zinkvej 6
8900 Randers

Tel.: +45 (0)87 11 90 60
Fax: +45 (0)87 11 90 61

Great Britain – Großbritannien

Bosch Rexroth Ltd.
Electric Drives & Controls
Broadway Lane, South Cerney
Cirencester, Glos GL7 5UH

Tel.: +44 (0)1285 863000
Fax: +44 (0)1285 863030
 sales@boschrexroth.co.uk
 service@boschrexroth.co.uk

Finland - Finnland

Bosch Rexroth Oy
Electric Drives & Controls
Ansatie 6
017 40 Vantaa

Tel.: +358 (0)9 84 91-11
Fax: +358 (0)9 84 91-13 60

France - Frankreich

Bosch Rexroth SAS
Electric Drives & Controls
Avenue de la Trentaine
(BP. 74)
77503 Chelles Cedex

Tel.: +33 (0)164 72-70 00
Fax: +33 (0)164 72-63 00
Hotline: +33 (0)608 33 43 28

France - Frankreich

Bosch Rexroth SAS
Electric Drives & Controls
ZI de Thibaud, 20 bd. Thibaud
(BP. 1751)
31084 Toulouse

Tel.: +33 (0)5 61 43 61 87
Fax: +33 (0)5 61 43 94 12

France – Frankreich

Bosch Rexroth SAS
Electric Drives & Controls
91, Bd. Irène Joliot-Curie
69634 Vénissieux – Cedex
Tel.: +33 (0)4 78 78 53 65
Fax: +33 (0)4 78 78 53 62

Italy - Italien

Bosch Rexroth S.p.A.
Via G. Di Vittoria, 1
20063 Cernusco S/N.MI

Tel.: +39 02 92 365 1
+39 02 92 365 326

Fax: +39 02 92 365 500
+39 02 92 365 516378

Italy - Italien

Bosch Rexroth S.p.A.
Via Paolo Veronesi, 250
10148 Torino

Tel.: +39 011 224 88 11
Fax: +39 011 224 88 30

Italy - Italien

Bosch Rexroth S.p.A.
Via del Progresso, 16 (Zona Ind.)
35020 Padova

Tel.: +39 049 8 70 13 70
Fax: +39 049 8 70 13 77

Italy - Italien

Bosch Rexroth S.p.A.
Via Mascia, 1
80053 Castellamare di Stabia NA

Tel.: +39 081 8 71 57 00
Fax: +39 081 8 71 68 85

Italy - Italien

Bosch Rexroth S.p.A.
Viale Oriani, 38/A
40137 Bologna

Tel.: +39 051 34 14 14
Fax: +39 051 34 14 22

Netherlands – Niederlande/Holland

Bosch Rexroth B.V.
Kruisbroeksestraat 1
(P.O. Box 32)
5281 RV Boxtel
Tel.: +31 (0)411 65 19 51
Fax: +31 (0)411 65 14 83
 www.boschrexroth.nl

Netherlands - Niederlande/Holland

Bosch Rexroth Services B.V.
Technical Services
Kruisbroeksestraat 1
(P.O. Box 32)
5281 RV Boxtel
Tel.: +31 (0)411 65 19 51
Fax: +31 (0)411 67 78 14
services@boschrexroth.nl

Norway - Norwegen

Bosch Rexroth AS
Electric Drives & Controls
Berghagan 1          or: Box 3007
1405 Ski-Langhus     1402 Ski

Tel.: +47 (0)64 86 41 00
Fax: +47 (0)64 86 90 62
 jul.ruud@rexroth.no

Spain - Spanien

Bosch Rexroth S.A.
Electric Drives & Controls
Centro Industrial Santiga
Obradors s/n
08130 Santa Perpetua de Mogoda
Barcelona
Tel.: +34 9 37 47 94 00
Fax: +34 9 37 47 94 01

Spain – Spanien

Goimendi S.A.
Electric Drives & Controls
Parque Empresarial Zuatzu
C/ Francisco Grandmontagne no.2
20018 San Sebastian

Tel.: +34 9 43 31 84 21
- service: +34 9 43 31 84 56
Fax: +34 9 43 31 84 27
- service: +34 9 43 31 84 60
 sat.indramat@goimendi.es

Sweden - Schweden

Rexroth Mecman Svenska AB
Electric Drives & Controls
- Varuvägen 7
(Service: Konsumentvägen 4, Älfsjö)
125 81 Stockholm

Tel.: +46 (0)8 727 92 00
Fax: +46 (0)8 647 32 77

Sweden - Schweden

Rexroth Mecman Svenska AB
Electric Drives & Controls
Ekvändan 7
254 67 Helsingborg
Tel.: +46 (0) 42 38 88 -50
Fax: +46 (0) 42 38 88 -74

Switzerland West - Schweiz West

Bosch Rexroth Suisse SA
Electric Drives & Controls
Rue du village 1
1020 Renens
Tel.: +41 (0)21 632 84 20
Fax: +41 (0)21 632 84 21

Switzerland East - Schweiz Ost

Bosch Rexroth Schweiz AG
Electric Drives & Controls
Hemrietstrasse 2
8863 Buttikon
Tel. +41 (0) 55 46 46 111
Fax +41 (0) 55 46 46 222
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Europa (Ost) - Europe (East)

vom Ausland: (0) nach Landeskennziffer weglassen  

from abroad:    don’t dial (0) after country code

Czech Republic - Tschechien

Bosch -Rexroth, spol.s.r.o.
Hviezdoslavova 5
627 00 Brno

Tel.: +420 (0)5 48 126 358
Fax: +420 (0)5 48 126 112

Czech Republic - Tschechien

DEL a.s.
Strojírenská 38
591 01 Zdar nad Sázavou
Tel.: +420 566 64 3144
Fax: +420 566 62 1657

Hungary - Ungarn

Bosch Rexroth Kft.
Angol utca 34
1149 Budapest

Tel.: +36 (1) 422 3200
Fax: +36 (1) 422 3201

Poland – Polen

Bosch Rexroth Sp.zo.o.
ul. Staszica 1
05-800 Pruszków

Tel.: +48 22 738 18 00
– service: +48 22 738 18 46
Fax: +48 22 758 87 35
– service: +48 22 738 18 42

Poland – Polen

Bosch Rexroth Sp.zo.o.
Biuro Poznan
ul. Dabrowskiego 81/85
60-529 Poznan

Tel.: +48 061 847 64 62 /-63
Fax: +48 061 847 64 02

Romania - Rumänien

East Electric S.R.L.
B-dul Basarabie, nr.250, sector 3
73429 Bucuresti

Tel./Fax:: +40 (0)21 255 35 07
+40 (0)21 255 77 13

Fax: +40 (0)21 725 61 21
 est@mb.roknet.ro

Romania - Rumänien

Bosch Rexroth Sp.zo.o.
Str. Drobety nr. 4-10, app. 14
70258 Bucuresti, Sector 2

Tel.: +40 (0)1 210 48 25
+40 (0)1 210 29 50

Fax: +40 (0)1 210 29 52

Russia - Russland

Bosch Rexroth OOO
Wjatskaja ul. 27/15
127015 Moskau

Tel.: +7-095-785 74 78
+7-095 785 74 79

Fax: +7 095 785 74 77
 laura.kanina@boschrexroth.ru

Russia - Russland

ELMIS
10, Internationalnaya
246640 Gomel, Belarus
Tel.: +375/ 232 53 42 70

+375/ 232 53 21 69
Fax: +375/ 232 53 37 69
 elmis_ltd@yahoo.com

Turkey - Türkei

Bosch Rexroth Otomasyon
San & Tic. A..S.
Fevzi Cakmak Cad No. 3
34630 Sefaköy Istanbul
Tel.: +90 212 541 60 70
Fax: +90 212 599 34 07

Slowenia - Slowenien

DOMEL
Otoki 21
64 228 Zelezniki
Tel.: +386 5 5117 152
Fax: +386 5 5117 225
 brane.ozebek@domel.si



MTGUI User Interface Service & Support 6-5

DOK-CONTRL-MTGUI***V23-AW01-EN-P

Africa, Asia, Australia – incl. Pacific Rim

Australia - Australien

AIMS - Australian Industrial
Machinery Services Pty. Ltd.
28 Westside Drive
Laverton North Vic 3026
Melbourne

Tel.: +61 3 93 243 321
Fax: +61 3 93 243 329
Hotline: +61 4 19 369 195
 terryobrien@aimservices.com.au

Australia - Australien

Bosch Rexroth Pty. Ltd.
No. 7, Endeavour Way
Braeside Victoria, 31 95
Melbourne

Tel.: +61 3 95 80 39 33
Fax: +61 3 95 80 17 33
 mel@rexroth.com.au

China

Shanghai Bosch Rexroth
Hydraulics & Automation Ltd.
Waigaoqiao, Free Trade Zone
No.122, Fu Te Dong Yi Road
Shanghai 200131 - P.R.China

Tel.: +86 21 58 66 30 30
Fax: +86 21 58 66 55 23
richard.yang_sh@boschrexroth.com.cn
 gf.zhu_sh@boschrexroth.com.cn

China

Shanghai Bosch Rexroth
Hydraulics & Automation Ltd.
4/f, Marine Tower
No.1, Pudong Avenue
Shanghai 200120 - P.R.China

Tel: +86 21 68 86 15 88
Fax: +86 21 58 40 65 77

China

Bosch Rexroth China Ltd.
15/F China World Trade Center
1, Jianguomenwai Avenue
Beijing 100004, P.R.China

Tel.: +86 10 65 05 03 80
Fax: +86 10 65 05 03 79

China

Bosch Rexroth China Ltd.
Guangzhou Repres. Office
Room 1014-1016, Metro Plaza,
Tian He District, 183 Tian He Bei Rd
Guangzhou 510075, P.R.China

Tel.: +86 20 8755-0030
+86 20 8755-0011

Fax: +86 20 8755-2387

China

Bosch Rexroth (China) Ltd.
A-5F., 123 Lian Shan Street
Sha He Kou District
Dalian 116 023, P.R.China

Tel.: +86 411 46 78 930
Fax: +86 411 46 78 932

China

Melchers GmbH
BRC-SE, Tightening & Press-fit
13 Floor Est Ocean Centre
No.588 Yanan Rd. East
65 Yanan Rd. West
Shanghai 200001

Tel.: +86 21 6352 8848
Fax: +86 21 6351 3138

Hongkong

Bosch Rexroth (China) Ltd.
6th

 Floor,
Yeung Yiu Chung No.6 Ind Bldg.
19 Cheung Shun Street
Cheung Sha Wan,
Kowloon, Hongkong

Tel.: +852 22 62 51 00
Fax: +852 27 41 33 44

alexis.siu@boschrexroth.com.hk

India - Indien

Bosch Rexroth (India) Ltd.
Electric Drives & Controls
Plot. A-58, TTC Industrial Area
Thane Turbhe Midc Road
Mahape Village
Navi Mumbai - 400 701

Tel.: +91 22 7 61 46 22
Fax: +91 22 7 68 15 31

India - Indien

Bosch Rexroth (India) Ltd.
Electric Drives & Controls
Plot. 96, Phase III
Peenya Industrial Area
Bangalore – 560058

Tel.: +91 80 41 17 02 -11...-18
Fax: +91 80 83 94 345

+91 80 83 97 374

 mohanvelu.t@boschrexroth.co.in

India - Indien

Bosch Rexroth (India) Ltd.
1st Floor, S-10
Green Park ext. Market
New Delhi – 110016

Tel.: +91 1 16 56 68 88
Fax: +91 1 16 56 68 87

Indonesia - Indonesien

PT. Bosch Rexroth
Building # 202, Cilandak
Commercial Estate
Jl. Cilandak KKO, Jakarta 12560

Tel.: +62 21 7891169 (5 lines)
Fax: +62 21 7891170 - 71

Japan

Bosch Rexroth Automation Corp.
Service Center Japan
Yutakagaoka 1810, Meito-ku,
NAGOYA 465-0035, Japan

Tel.: +81 52 777 88 41
+81 52 777 88 53
+81 52 777 88 79

Fax: +81 52 777 89 01

Japan

Bosch Rexroth Automation Corp.
Electric Drives & Controls
1F, I.R. Building
Nakamachidai 4-26-44, Tsuzuki-ku
YOKOHAMA 224-0041, Japan

Tel.: +81 45 942 72 10
Fax: +81 45 942 03 41

Korea

Bosch Rexroth-Korea Ltd.
Electric Drives and Controls
Bongwoo Bldg. 7FL, 31-7, 1Ga
Jangchoong-dong, Jung-gu
Seoul, 100-391

Tel.: +82 234 061 813
Fax: +82 222 641 295

Korea

Bosch Rexroth-Korea Ltd.
1515-14 Dadae-Dong, Saha-Ku
Electric Drives & Controls
Pusan Metropolitan City, 604-050

Tel.: +82 51 26 00 741
Fax: +82 51 26 00 747
 gyhan@rexrothkorea.co.kr

Malaysia

Bosch Rexroth Sdn.Bhd.
11, Jalan U8/82, Seksyen U8
40150 Shah Alam
Selangor, Malaysia

Tel.: +60  3 78 44 80 00
Fax: +60  3 78 45 48 00
 hockhwa@hotmail.com
 rexroth1@tm.net.my

Singapore - Singapur

Bosch Rexroth Pte Ltd
15D Tuas Road
Singapore 638520

Tel.: +65  68 61 87 33
Fax: +65  68 61 18 25
 sanjay.nemade

@boschrexroth.com.sg

South Africa - Südafrika

TECTRA Automation (Pty) Ltd.
71 Watt Street, Meadowdale
Edenvale 1609

Tel.: +27 11 971 94 00
Fax: +27 11 971 94 40
Hotline: +27 82 903 29 23
 georgv@tectra.co.za

Taiwan

Bosch Rexroth Co., Ltd.
Taichung Branch
1F., No. 29, Fu-Ann 5th Street,
Xi-Tun Area, Taichung City
Taiwan, R.O.C.

Tel : +886 - 4 -23580400
Fax: +886 - 4 -23580402
jim.lin@bosch-rexroth.com.tw
david.lai@bosch-rexroth.com.tw

Thailand

NC Advance Technology Co. Ltd.
59/76 Moo 9
Ramintra road 34
Tharang, Bangkhen,
Bangkok 10230

Tel.: +66 2 943 70 62
        +66 2 943 71 21
Fax: +66 2 509 23 62
 sonkawin@hotmail.com
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Nordamerika – North America
USA
Headquarters - Hauptniederlassung

Bosch Rexroth Corporation
Electric Drives & Controls
5150 Prairie Stone Parkway
Hoffman Estates, IL 60192-3707

Tel.: +1 847 6 45 36 00
Fax: +1 847 6 45 62 01
servicebrc@boschrexroth-us.com
 repairbrc@boschrexroth-us.com

USA Central Region - Mitte

Bosch Rexroth Corporation
Electric Drives & Controls
Central Region Technical Center
1701 Harmon Road
Auburn Hills, MI 48326

Tel.: +1 248 3 93 33 30
Fax: +1 248 3 93 29 06

USA Southeast Region - Südwest

Bosch Rexroth Corporation
Electric Drives & Controls
Southeastern Technical Center
3625 Swiftwater Park Drive
Suwanee, Georgia 30124

Tel.: +1 770 9 32 32 00
Fax: +1 770 9 32 19 03

USA SERVICE-HOTLINE

- 7 days x 24hrs -

+1-800-REX-ROTH
+1-800-739-7684

USA East Region – Ost

Bosch Rexroth Corporation
Electric Drives & Controls
Charlotte Regional  Sales Office
14001 South Lakes Drive
Charlotte, North Carolina 28273

Tel.: +1 704 5 83 97 62
+1 704 5 83 14 86

USA Northeast Region – Nordost

Bosch Rexroth Corporation
Electric Drives & Controls
Northeastern Technical Center
99 Rainbow Road
East Granby, Connecticut 06026

Tel.: +1 860 8 44 83 77
Fax: +1 860 8 44 85 95

USA West Region – West

Bosch Rexroth Corporation
7901 Stoneridge Drive, Suite 220
Pleasant Hill, California 94588

Tel.: +1 925 227 10 84
Fax: +1 925 227 10 81

Canada East - Kanada Ost

Bosch Rexroth Canada Corporation
Burlington Division
3426 Mainway Drive
Burlington, Ontario
Canada L7M 1A8

Tel.: +1 905 335 55 11
Fax: +1 905 335-41 84
 michael.moro@boschrexroth.ca

Canada West - Kanada West

Bosch Rexroth Canada Corporation
5345 Goring St.
Burnaby, British Columbia
Canada V7J 1R1

Tel. +1 604   205-5777
Fax +1 604   205-6944
 david.gunby@boschrexroth.ca

Mexico

Bosch Rexroth Mexico S.A. de C.V.
Calle Neptuno 72
Unidad Ind. Vallejo
07700 Mexico, D.F.

Tel.: +52 5 754 17 11
+52 5 754 36 84
+52 5 754 12 60

Fax: +52 5 754 50 73
+52 5 752 59 43

mariofelipe.hernandez@boschrexroth.com.mx

Mexico

Bosch Rexroth S.A. de C.V.
Calle Argentina No 3913
Fracc. las Torres
64930 Monterrey, N.L.

Tel.: +52 8 333 88 34...36
+52 8 349 80 91...93

Fax: +52 8 346 78 71
mario.quiroga@boschrexroth.com.mx

Südamerika –  South America
Argentina - Argentinien

Bosch Rexroth S.A.I.C.
"The Drive & Control Company"
Acassusso 48 41/47
1605 Munro
Provincia de Buenos Aires

Tel.: +54 11 4756 01 40
Fax: +54 11 4756 01 36
victor.jabif@boschrexroth.com.ar

Argentina - Argentinien

NAKASE
Servicio Tecnico CNC
Calle 49, No. 5764/66
B1653AOX Villa Balester
Provincia de Buenos Aires

Tel.: +54  11 4768 36 43
Fax: +54  11 4768 24 13
 nakase@usa.net
 nakase@nakase.com
 gerencia@nakase.com (Service)

Brazil - Brasilien

Bosch Rexroth Ltda.
Av. Tégula, 888
Ponte Alta, Atibaia SP
CEP 12942-440

Tel.: +55 11  4414 56 92
+55 11  4414 56 84

Fax sales: +55 11  4414 57 07
Fax serv.: +55 11  4414 56 86
 alexandre.wittwer@rexroth.com.br

Brazil - Brasilien

Bosch Rexroth  Ltda.
R. Dr.Humberto Pinheiro Vieira, 100
Distrito Industrial    [Caixa Postal 1273]
89220-390 Joinville - SC

Tel./Fax: +55 47 473 58 33
Mobil: +55 47 9974 6645
 prochnow@zaz.com.br

Columbia - Kolumbien

Reflutec de Colombia Ltda.
Calle 37 No. 22-31
Santafé de Bogotá, D.C.
Colombia

Tel.: +57 1 368 82 67
+57 1 368 02 59

Fax: +57 1 268 97 37
reflutec@neutel.com.co
reflutec@007mundo.com
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Notes



Bosch Rexroth AG
Electric Drives and Controls
Bgm.-Dr.-Nebel-Str. 2
97816 Lohr, Germany
info@boschrexroth.de
www.boschrexroth.de

Printed in Germany
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